2.0

Document Basics

In order to accomplish an electronic filing, an ECF user will often be
required to attach an image of the document being transmitted. This
pleading must be in a Portable Document Format or PDF using Adobe
Acrobat software. This section of the manual is designed to familiarize
the ECF user with the procedures for preparing, converting and attach-
ing PDF documents to the ECF system.

This chapter will cover:

Creating the Pleading

Converting the Document to PDF

More About Adobe Acrobat

Combining Different PDF Documents Together
Attaching a PDF Document in ECF

Additiona Attachments.
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Remember : Additional
preparations are necessary
when creating a proposed
order for electronic upload.

When preparing a proposed
order, leave atwo and a half
inch margin at the top of the
first page and indicate the | ast
page with an“END OF
DOCUMENT” statement.

Refer to the L ocal Rules and
the order upload instructions
in Section 7: Filing Docu-
ments on the System, for
more information.

Hint: If youarecreatinga
document that will include
noticing information, such as
a Notice of Hearing or Cer-
tificate of Service, you may
refer to section 10.5: Recipi-
ent Mailing List, for the list
of electronic and manual re-
cipients. You may thenin-
clude on the noticing docu-
ment, (Received Electroni-
cally), before converting to
PDF, to indicate how the
parties were proved notice.

Creating the Pleading

STEP1

STEP2

STEP3

Createthe“Base” document. This can bedonein
any word processing program, such as Microsoft
Word or Corel WordPerfect.

Be sure to indicate [Filed Electronically] and check
date and signature lines (See example pleading on

next page).

We suggest you set the default font to Courier
(NOT Courier New or Times New Roman or
any other TrueType font). Tests have shown
that using True Type fonts drastically increases
the size of the document and some illegal fonts
create noticing issues. Set the default font by
going to "File --> Document --> Default Font."

Before printing, perform a"File--> Save As' and
save the document as a norma WordPerfect
document. This cleans the document and gets rid of
any embedded code that might be lingering due to
editing, but that is not visible in the actual document.
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EXAMPLE PLEADING

In the United States Bankruptcy Court
Digtrict of Utah, Central Division

In Re: Bankruptcy Case Number
Debtor(s) [Chapter 7]
[Filed Electronically]
Title of Pleading

Body of Document
Prayer

Dated this 20" day of January, 2004
Remember to date and sign your motion if converting immediately to PDF.

/s Michelle Bugni
Attorney for Debtor

Certificate of Mailing
Roger G. Segd
(Received Electronically) (Indicate the method of notice)

Jeffrey H. Hagen
Whatcott Barrett & Hagen
1846 South 300 West

Salt Lake City, Ut 84115

Kent W. Plott
3269 South Main Street, Ste. 100
Salt Lake, UT 84115
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2.2

Converting a Document to PDF

Legal documents may con-
tain web references and
footnotes, which could
cause an error when con-
verting the document to
PDF. The message reads,
“Error: Document con-
tains external web refer-
ences’. Informationis
provided in section 2.3
about the error.

Do not use the PDF Crea-
tor that isa part of the
Corel Quite, or Publishto
PDF available in Word-
Perfect

Converting the Pleading to a PDF document basically consists of
“printing” to the Adobe Acrobat application instead of a printer.
Below are the steps to convert a document from aword processing
program

STEP1 Print the document. After you have created your
document, click on the application’s print icon or
go to File> Print. In MS Word, the Printer
windows appears. WordPerfect’s print window is
about the same. Here you will change your printer
driver using the drop-down menu box (see figure
1). The Adobe PDFWriter is highlighted. After
highlighting your se lection click on the [OK]
button. Y ou will then get a Save PDF File As
window.

STEP2 Giveyour PDF filea nameand click on the [Save]
button. Y our PDF document should now be saved
to your specified location.

WordPerfect 9.x and later allows you to create a
PDF document from WordPerfect by selecting File
> Publish to PDF. This method may cause some
corruption in the file and is not recommended.
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Creating a PDF from a Scanned Document

Creating a PDF document from a scanned image is very similar, in
that you will print the document to Acrobat.

Scanned documents converted to PDF can sometimes create larger
file sizes than that of a document created in a word processing pro-
gram, converted to PDF. ECF allows a document size of 2MB
per attached image, which is roughly 50 pages of a document cre-
ated from a word processing application. So if you use an optical
scanner to create your PDF document, the number of pages may be
decreased. The scanning guidelines below are intended to aid users
in the preparation of PDF documents using a scanning device.

Scanning Guiddlines

Quality and File Size

The quality of a document when scanned is determined by the
level of detail recorded by the scanner. The detail is referred to as
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resolution, which is measured by dots per inch or “dpi.” A document scanned
with a higher dpi will have a larger file size and will take longer to scan than a
document with alower dpi.

A document which is scanned at a higher dpi will require alonger download-
ing period when filing it with the ECF system. Additionally, retrieval of the
filed document will be dower for PACER and CM/ECF users.

The court recommends documents are scanned between 200-300 dpi in order
to minimize file size as well as efficiently upload and retrieve CM/ECF docu-
ments filed with the Court. The software used for scanning documents should
be properly configured to this setting when possible.

ECF users should be diligent while scanning to make sure the image is clear
and readable before filing it in the ECF system. Documents which are noticea
bly skewed or unreadable, will be marked as a possible error on the docket
sheet.

If users plan to scan exhibits which have been previously copied, the copies
should be as “clean” as possible. Copies which contain dark areas and any
copy distortion will inflate a file size. Make sure the copies are clear as possi-
ble before scanning.

Mode

The mode of scanning can also impact file size. Mode of scanning can include
“photograph”, “grayscale” or “black and white.” ECF users should almost al-
ways use the “ black and white” mode when scanning documents to file with
the court.

Limitson Size

The maximum size of a PDF file which can be filed with the ECF system is 2
Megabytes (MB). If auser attempits to file a document or attachment larger
than 2MB, awarning will be displayed which forces the user to stop the filing.
If a document is too large for filing, a user must separate the document into
smaller parts using the Adobe Acrobat software.
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2.3

More About Adobe Acrobat

Adobe Acrobat is an application that creates a file known as a Portable Document
Format. Thisfileisthe electronic copy of the origina document that you created.
As discussed is Section 2.2, your scanner and Adobe settings can have an effect

on the size of your file and subsequently, the number of pages and time it takes to
download. This section will provide additional information about Adobe Acrobat.

With Adobe 6.0 now available, there have been questions about compatibility.
This chapter will include some issues that we are aware of, and further tests are
being done.

You may also refer to the materias provided with your software or the Adobe
website at www.adobe.com for instructions on the use of different featuresin
Adobe such as the Comments Side Bar, Notes and Highlight tools.
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Note: This hint does not
apply to WordPerfect 10
userswho do not have
the "Details" tab. Don't
worry, initial tests have
shown that WordPerfect
10 creates MUCH
smaller PDF files than
WordPerfect 9.

Instructions for chang-
ing setting may differ,
depending on the ver-
sion you are using.

Resolution Settings

We recommend 300 x 300 dpi resolution. A higher resolution appears to dra-
matically increase the file size. Because Adobe Acrobat is often used for
publishing, some of the standard settings have a 1200x1200 resolution.

When you print the document from your word processing program to Adobe
Acrobat, click on the "Details’ tab in the "Print" window that will appear,
change the Resolution to 200x200 or 300x300, then un-check the following
check boxes, "Print in color" and "Print text only."

In Adobe Acrobat 6:
1. Gointo Advanced —> Acrobat Distiller

2. From Acrobat Distiller, set the following:
—Default Settings. Smallest File Size

Compatibility with Older Versions of Adobe

Changing the compatibility to Acrobat versions 4.0, 5.0, or 6.0 had no effect
on the size of the saved file. In order to ensure the document is viewable in
Acrobat 4.0, set the compatibility to Acrobat 4.0 (PDF 1.3). To change the
compatibility, set the following from Acrobat

Distiller: Settings --> Edit Adobe PDF Settings --> General --> Compatibil-
ity --> Acrobat 4.0 (PDF 1.3).
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Web Reference Error

Legal documents may contain web references and footnotes, which
could cause an error when converting the document to PDF. If you
have embedded links within your PDF document, the message
reads; “Error: Document contains exter nal web references’.

Y our document may contain external cross references such as web
links or files. Footnotes in Word Documents can also be seen as
“embedded web references’. This has been noted with Acrobat 5.0
and Microsoft Office 2000 using the “Convert to Adobe PDF” bu-
ton on the Word toolbar to create the document.

In Acrobat 5.0, try the option
Tools—>PDF Consultant—>Detect and Remove to are-
lyze your document for external references.

Y ou may want to check the original document for footnotes or erd-
notes through View—> Footnotes.

When the PDF document is created there is an option for Word
Features to preserve Footnote & Endnote Links. Deselect this op-
tion. The Footnotes will no longer be preserved as links and the
PDF document should upload successfully.

For Acrobat 6.0 users, the instructions on the next page were taken
directly from the Adobe web site.
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; ,ﬁ Acrobat® 6.0 Professional

Editing links

Y ou can edit a link at any time. Y ou can change iis appearance, hotspoi area, or associated
link action; delete or resize the link rectangle; or change the destination of the link.
Changing the properties of an existing link affects only the currently selected link.

Q You can change the properties of several links a1 once if vou select the links using
the Link too] or the Select Object 1ool.

To move or resize a link rectangle:

.
. Select the Link tool W or the Select Object 1ol K , and then move the pointer over the

link rectangle, The cross hair changes to an arrow when the cursor is over a corner. If the
cursor is not directly over a comer of the link rectangle, the cursor is a standard pointer.
Do one of the following:

To move the link réctangle, position the mmow anywhere in the rectangle, and drag it 1o
the new location.

['o resize the link rectangle, drag any comer point untl the rectangle is the size you want.

To change the properties ol a link:

-
1

Select the Link ool U or the Select Object tool k  and double-click inside the link
reclangle to open the Link Properties dialog box.

Change the appearance of the link or edit the actions triggered by the link, and <lick OK.
(See Creating links.)

Note: If the Locked option is selected in the Link Properties dialog box, you need to
deselect it before you can edit the link properties.

To delete a link:

Select the Link wol W or the Selact Object 100l k , and select the link rectangle you wani
to delete.

Do one of the following:
Choose Edit > Delete.
Pres= the Delete key.

Choose Edit = Delete in the contaxt menil.
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Viewing PDF Documents in Microsoft |E 6.0 or XP Operating
Systems

A filer may experience viewing problems is using Microsoft 1E 6.0 and
Microsoft XP operating systems.

To view the PDF documents using the above software you must change
the settings in Adobe Acrobat software (Reader or Writer).

From the Adobe menu bar select Edit,

Then select Preferences

Then General
Piefetences B
The “preferences” rccorably 2] [ WebBrowser Options
window will open :::w :;?:mfm I iy s hiomnss
(see figure 1). Comments { ¥ Check Browsar Settngs When Startiv Acrobat |
Select “Options” b I™ Ellow £2st Wb Vew |
. i V' low Beckground Dosrioadng ‘
from the list. Extract Images It ; o R R
Forms S
Under the “Web F:i Screen T Startp — - S
J Identity 3
Browser optlonS,” Java.‘:cnpt | |7 MW SJIaSh sueen
Layout Grid | I Certified Plog-ns Only

uncheck the boxes: s

"Display PDF in M - Mscelaneas

Search
Browser" and Sef i Secuty ? i ”39“:“*“’
" Speling v Lise Logical Page Nurbers
Alloxv Fast Web TU‘:hUp [V Alow Eil2 Open Actions and Launching Fle Attachments
View" and click ok e O Coom oot ke o o
to accept the I~ Shp Eiting Werrings
changes_ ‘ [V Saye As Optimizes for Fast Web View
| | sk AY Warriegs |
R = O Pt . PLAL T ife i)
(o] e |
Figurel
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Known Problems Using Adobe Acrobat Version 6.0

There have been a few problems which have come up concerning Adobe Acrobat
6.0, Microsoft Word, PDF Distiller and uploading documents into the E-Orders up-
load system.

Adobe Acrobat 6.0

One issue is compatibility with other versions. By default, it appears that version 6.0
creates PDF documents compatible to version 5. But the user will also need to set
the compatibility to 4.0 (PDF 1.3).

Use the following steps:

1. Open up Acrobat 6.0.

2. Once itis up, click on Advanced > Acrobat Distiller. Distiller will launch.

3. On the Adobe PDF Settings, set the Default Settings to Smallest File Size (1)
using the drop down menu.

4. Now click on Settings in Distiller.

5. Click on Edit Adobe PDF Settings. Set Compatibility to Acrobat 4.0 (PDF
1.3). Change the Object Level Compression to Off.

6. Click on OK and save the new settings.

7. Close out Distiller.

Smallust File Sizo - Adobo POF Sattings B

Seneral | magss || Fonis | Color | Advanced | FOF/%

Dszcaphon

Lkni Frana sattingg in crasia POF dotuncnis with minnum negs meclibon and no
ant enbeddng. The POF documents can be ppened wih fombat and Feader 510
aned l=ier

i / Set Compatibility to Acrobat 4.0 (PDF 1.3)

Compatibity: | ‘ormbal 4.0(POF 1.3)

Dt Lewed Ciornpresaion: | O "

B = \ Change the Object Level Compression to Off
Bnding: 1o -
Ragoltion: GO0 | dols parnch
v 4l Papes
{ s Pages From Te
1 Embad thumbneits

= | Otz fiar Pagt meads e

Tkh: | 6128 Unda: |Poinis w

Haight: | 732
= ok | [ cames | [__Hee
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Microsoft Word 2000 and Adobe Acrobat Version 5.0

If you use Word and the Adobe link on the Word Toolbar, you will need to make
some settings changes to ensure that your document can by uploaded into the sys-
tem.

Click on the PDF Maker icon on the toolbar. The PDF Maker window will appear.
In the Creation options, click on Use Acrobat PDFWriter (PDFWriter has to be in-
stalled). Click on Apply, then Create. You will get a small window warning you
that you are using PDFWriter instead of Distiller, with a

list of items that will not be performed to your document T~
(which items you don’t want added to your document).

The PDF document will be named the same as your » F2). (| '@|
original document in the same folder. Tk

Acrobat® PDFMaker 4.0 for Microsofti Word | Acrobat PDFMaker ] i!

General I Cutput | Bookmarks | Display options I Mote: ¥ou have selected bo create a PDF file uzing Acrobat
PCFiriter, Whern using this option, PDFMaker's enbanced
— Creation options features are not available, The PDF file you are about ta
create will mok contain boakmarks, links, text notes, threads,
{#" Use Acrobat PDFuiiter or document information, Ta create a POF file with these
i Use Acrobat Distillar features, you must use Acrobat Distiller. This option is
disabled if you da not hawe Acrobat Distiller installed.

[¥ | Frirtt iz Distiler's pricter

[rstillet sethings: I:'.:::'r:.zr:Op'lrmze-.‘_- "i

~ File options [T use acrabat Distiller
[~ Prampt Far the POF Alename

V¥ Wiew the FDFE Ale after creating it

fé‘ Report errors

[V Delete the oz and | log Ales Cancel
Restore Defaults
e e x|
e AER e Configuring Diztiller... Dane
N et Converting Headings 2 Styles to Bookmarks.., [one
A Acrobat Distillar 4. installed e Cil 5
reating Internet links... ane
Adobe Microsof Word 9.0 i 2 3
Creating Crosz-docurnent links... Dane
Creating Cross-reference 2 TOC links.. [rone
Creating Footnote & Endnote links... Dane
Create i Ernail Canicel Help Arplhy | Creating Page labels... Biore
Cormverting Cornmments to Motes. ., Crame
Corverting Text boxes to Article threads... Dane
Converting Document information, .. Crone
Mapping docurment structure, .. Skipped
These are the items added to your PDF document Distilling - Starting the job
if you use distiller, and which cause problems with
the ECF system.
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Combining PDF Documents

Currently , the system
requires documentslar-
ger than 2MB (roughly
50 pages) to be broken
up into segments.

Do not combine eventsthat are
required to appear separately on
the docket sheet. For example,
you would not combine a Notice of
Hearing to a motion. But certifi-
cates of service are sometimes
combined with motions and no-
tices. Also, Statements and Sched-
ules are filed as one document but

cannot be combined with a 13 Plan.

More examples:

Notice of Intent can be combined
with Statements and Schedul es.
Motions and exhibits can be com-
bined, if document is under 50
pages or 2MB.

Occasionally you will have separate document files in your database that
will need to be included in one event filing. Possibly an exhibit or syp-
plemental documentation. The file may also be too large to file as one
document or the client may have emailed the document and you saved it
in a separate database folder. In these situations, the court would rather
the filer combine these documents into one PDF file before attaching it to
your filing. There are a couple of ways you can accomplish this.

This section will cover the suggested method for combining these docu-
ments together. Section 2.6: Additional Attachments will demonstrate
the other method. In an effort to streamline courtroom proceedings, it is
highly recommended that, whenever possible, ECF filers combine PDF
documents together and minimize the use of the Attachments to Docu
ments option that is discussed in section 2.6 of this manual.

STEP1 First your scanned or word processing documents are
converted and saved as PDF files, using the procedures
outlined in the previous section 2.2

STEP2 The filer then opens the first document in the Adobe

Acrobat application and select the Document menu option
at the top of the application window (see figure 2, saved
as Document 1.PDF).

From the Document drop-down menu, select Insert Pages.
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Figure2
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STEP 3 Y ou will then be prompted to select the PDF file that you
would like to combine with Document 1. Figure 3 shows
Document2. PDF as the selected document to be combined
with Documentl. Click on the [Select] button.

Select File To Insert EdEd

Loak jr: I{Eﬂ.ﬁ.ty Trugtee Training j gl

] Attarney matenialz

] Lists

1 Trustee materials

'@ consentform, pdf

E creditcardform. pdf

T CreditCardinfo. pdf

E Document! POF

@ Docurments PD

ﬂ ECFadminProcedures. pdf
'@ failed enotification, padf
T Microsoft<P |E.pdf

'@ ztylegquide namingcorny. pdf

File name: IDucument2.F‘DF Select I
Files of tope: !ﬂ«dnbe PDF Files [ pdf] - Cancel |
Sethinge.. |
o

Figure3
STEP4 The window in Figure 4 will ask where you would like the in
serted document to appear. If you are combining exhibits to a
motion, you would probably want to select After Last Page.
Click [OK]
U.S. Bankruptcy Court-District of Utah 54 July 2, 2004

Training Department



Inzert Pages

Insert File: "Documentz . PDF"

Location: I.ﬁ.Fter

— Page
‘ Before \

r

" First

s Last

" Page: |l af 1

(8.4

Zancel

Figure4
The documents are then combined into one file and are
ready to be included in your docket entry at the
[Browse] screen in ECF.
Remember: Always verify all documents before
attaching them to your entry.
July 2, 2004 55

U.S. Bankruptcy Court-District of Utah
Training Department



Attaching a PDF Document

CM/ECF requires a PDF document to support the electronic fil-
ing that you are performing.

This section will cover how to attach you PDF document to a
ECF filing.

STEP1 When you need to attach a PDF document to
your filing, a screen similar to the one shown in
Figure 1 will appear.

The PDF Association/Attachment screen may
contain other items, such as the Fee field shown
in Figure 5.

STEP 2 You may enter the file path (C:\My Documents
\Training\Document.pdf) if you know it. But it
is preferred that you use the [Browse] button so
that you are able to verify the document before
submitting it to the court.

BB e Ceiidn B
w w3 4 e w3 O #
Bk,

Pieid  Fmm S lewos Pre Boek  So

(220100 Chantel 5. Oakes

[Foe: §73

Select the pdf document (for exampla; OO0 99ev501-2] pdf),
Filemaniae
[ .

Attachments to Document: « Mo ~ Yes

Hext|  Clear [
- I ——d Lim o wa ot TR
Figure 5
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Y ou will see the Choose filewindow. If you
are using Netscape 4.x, you will need to click
on the Files of type drop-down menu and then
select All Files (*.*) (seefigure 6).

Navigate to your file location by using the
drop-down menu in the Look in field.

STEP3 Once you have found your desired PDF docu-
ment, it is a good practice to click on it once to
highlight the file, then right-click. Select Open
from the pop-up menu (see figure 7). This will
launch Adobe Acrobat and allow you to review
the document that you are attaching to be sure
that it is the one you want attached to the
filing.
After you have verified the document, you
can close, or minimize Adobe Acrobat, and
then click on the [Open] button.
STEP4 Once you have attached your PDF document,
you can then click on the [Next] button to pro-
ceed with your filing.
0 o District of Utsh - Train Database - St
O Choose file =—i——~== H IMHEJJ B JJEI
— | 2 o] B
Lok jn: IﬁTraining j||‘| “":A;—'hT!-'—'—'—
Aty M anual Eclaimlpdf ﬁubiection.pdf Cail  pen
CD Instruction Ecomplaint‘pdf Eﬂehef_stay‘pdf ll::: !
4d_protpdf ﬂConfirnﬂ.pdl Eﬁeport sale. pdf i M Piotizen Cocn
advoid Lienpdf ) Confim2.pdf Shen g S
angwer,pdf Etonfirmlpdl 3 %:,:E“Th, m
apl_employl pf '@Eonfirmd.pdl e — m
apl_pay_instal pdf ﬂHenick_vol.pdf E—— ; IL";
FiiP v J
File name I Open ; Eq
Il Files of type: &l Fies [ - [m | ; Cuase Chovmut
- £l Files [27] L EJ ﬂ] ﬁ
Fictures [* f, * jpg) =
I HTML (% e, * himl] Fuutes
ttackments o Document: © Ho O Yes
Figure6 Figure7
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Additional Attachments

ECF usersare encouraged to
combine PDF documentsinto
one pleading, whenever possible.
Instructions on how to compile
PDF documents can be foundin
Section 2.4: Combining PDF
Documents.

If the PDF document you are filing has exhibits or additional
documentation, you may identify these support documents as at-
tachments. Additionally, if the pleading you are filing exceeds
2MB (roughly fifty pages) in length you will be required to
break this document up into segments. Y ou may combine docu-
ments as demonstrated in section 2.4 of this manual or by select-
ing the Yesradio button next to Attachments to Document below
the Filename field shown in Figure 5 in previous section. The
screen in Figure 8 will appear.

5% Dintnct ol Ule® - Uy Dalabans - Retccam

(B 8 Yee G [eresces D

- = A 4 » = S 8 9 6 ﬂ
| B Fuboed  Homn  Gpech Mebwww Fav Swosly - B

T lweeririne (3wt S rain B Peee B viarie (5 Dmelad T Cosvan U Traves
U b Beknabs B Loomon e ens ) i sm a g Aogen TSRS AL L_FIE. M

1} Enter the pdfl document that contains attachment (lor example; C:appendis, pdi)
Filename

H:vTrainimg docs' Documentl St Ll

2 Select a document type andior énter 4 descrniption

Type Description

[Exhibit H|rrusc peed

30 Add the filename to the list box below. If you have more attachments, go back to Step L.
When the list of filenames 15 complete, click on the Next button.

H\Training docskattachmentdocd pdf =

Addto Lisf
g Rermove from List
| Next | 3
L Dt Lo L TR R -
Figure8
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STEP1 Each attachment will be added separately using
the browse procedures outlined in the previous
section 2.5: Attaching a PDF Document.

STEP 2 Y ou may further identify the attachment, in step
2, by selecting a document type or typing in a
description or both.

STEP 3 You are required to add the document on the list
of attachments for the pleading you are filing by
clicking on the [Add to List] button. Repeat
steps 1-3 if you have additional attachments.

Once you have included all support documenta
tion click on the [Next] button to continue.

The attachments are identified separately and
will display the description of the document in
the final text as shown in Figure 9.

B Bl Yew o [ownsiosl Hie

W & 34 A a H oS W 3 1 E
Bk Folsd  Homs  lomck Mpbeapw Pl Beonly She
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Motion for Relief From Stay OF Test Fes Amount 576 Filed by Wells Fargo Bank
tAbtachments: & (11 Exhikit Trusk Deed? (2] Exhibit Trust Deed) (mobaty, |

Attention! | Subtmitting this seréen commits this transaction. You will have
no further oppartunity to maodify this submission 1F you continue

Pt Clear

1] 1 _-I‘"
== T = Tt Sda oI (1 £

Figure9

You must use one or both the type
and/or description fields before
adding to thelist.
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NOTES
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